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COMMERCIAL SAMPLE ROASTER

This appliance is suitable for professional use and is also intended to be used in 
household and similar applications (such as staff kitchens in workplaces, farm 

houses, and for client use within the hospitality industry), provided that either (i) 
the user can manage the flow of smoke so that smoke detector alarms are not 

activated, or (ii) the user can safely temporarily disable smoke detector alarms in the 
vicinity of the appliance in accordance with the smoke detector manufacturer’s or 

building owner’s instructions. 
 

This appliance is not suitable for use in a building within range of smoke detectors 
that are directly connected to a sprinkler system or to the fire service.

Model KN1007B/E  
Firmware version 7.7 or higher 

SAFETY 
This is an electrical appliance that contains sophisticated electronics. Like other 

cooking appliances, such as a toaster, if something goes wrong it could start a fire.

Thank you for joining the LINK coffee roasting community. We strive to empower 
our users to roast, brew and cup coffee to the best of its potential, in an accessible 

and approachable way. 
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This is an electrical appliance that contains sophisticated electronics. Like other cooking 
appliances, such as a toaster, if something goes wrong it could start a fire.

1.	 Read all safety instructions before use.

2.	 For indoor use only, or under a covered surface outside.

3.	 Use upright on a solid level surface.

4.	 Do not overload.

5.	 Use only for roasting green coffee beans. Although it contains many safety 
features, other substances – such as popcorn or nuts – could mislead the 
safety checks and may result in fire or damage to the appliance.

6.	 If you operate the appliance on an induction cook top, the appliance feet must 
be at least 20mm above the cook top surface, e.g. by using a chopping board 
or thick mat. This prevents the cook top from detecting the appliance as a pan.

7.	 Use only with adequate ventilation, preferably close to a kitchen extractor fan.

8.	 Use at least 100mm away from walls and 150mm away from curtains measured 
horizontally.

9.	 Make sure that nothing blocks the air inlet (under the base) or outlet (at the 
top) when the appliance is in use. Slowing the air down will cause it to heat 
faster. It will ruin a batch of coffee if the safety systems shut it down midroast, 
and if the air is completely blocked it could damage the appliance or start a fire.

10.	 Keep the area around the appliance free of spilled chaff and other loose 
material that could be sucked into the roaster during operation.

11.	 Remain in the vicinity while the appliance is running.

12.	 This appliance is not intended to be operated by means of an external timer or 
separate remote control system.

13.	 May trigger a smoke alarm during normal operation. Ensure that you follow 
the smoke alarm manufacturer’s instructions if you need to temporarily 
disable a smoke alarm during the operation of the coffee roaster. Do not use 
this appliance in a commercial building where smoke detectors may trigger 
sprinklers, a building evacuation or fire service call out.

14.	 Wait until the cool down part of the roasting cycle has finished before removing 
the chaff collector.

15.	 Do not immerse the base unit in liquid. Use a damp cloth to wipe it down if 
required. Water will damage the electronics. For more information on cleaning, 
see the section on ‘Cleaning’.

IMPORTANT SAFETY
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16.	 If liquid enters the roast chamber or any other part of the appliance, unplug 
the power supply and allow 24 hours in a warm place for the interior of the 
appliance to dry completely before attempting to use the appliance again.

17.	 If damaged, the supply cord must be replaced by a qualified technician.

18.	 Do not open the casing of the roaster. There are live wires in the appliance, 
so there is a risk of electrical shock.

19.	 Contact the distributor if you see persistent error messages on the display.

20.	 The symbol          means ‘Caution: hot surfaces.’

21.	 If a foreign substance (such as rice, flour or liquid) gets into the roast 
chamber you should have a service technician strip and clean the appliance 
before you attempt to use it again. This is because such substances can 
fit between the fins and get onto the element or fan motor inside the 
appliance.

22.	 It is advisable to plug the roaster directly into the power supply without 
using an extension cord.

WELCOME TO THE LINK
The LINK is a professional coffee sample roaster, created in collaboration between Nucleus 
Coffee Tools and Kaffelogic. Designed for samples between 50g - 100g, it is comprised 
of three components: a specialised smartphone app, a desktop-based program and the 
roaster itself. 

This sample roaster was designed to make coffee roasting more afforable, accessible 
and technologically advanced – allowing anyone in the world to roast quality samples, no 
matter their experience level or where they are. 

We welcome you to your new roasting journey, and invite you to reach out to our 
community to learn more.  

Welcome to the LINK
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PARTS LIST

Control Display (see next page)

Control Buttons (see next page)

On/Off Button

Hopper

Chaff Collector

Body
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CONTROL PANEL

Development % 
(DTR%)

Roast 
Temperature

Roast 
Time

Minus Button 
Reduce Selections

Plus Button 
Increase Selections

Profile Button 
Selects Profile

Play Button 
Confirm Selection 

or 
Start Action

Menu Button 
Opens Menu

00:22 10.2*
208  >213.8º[2.9]

62.6
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Military Grade Travel Case

Dosing Cup Density Tube Tray

ACCESSORIES
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BEFORE FIRST USE

TESTING

1.	 Remove all packaging, including the interior packaging around the chimney 
inside the chaff collector.

2.	 Go to the Nucleus Coffee Tools website and activate your warranty.

3.	 Please read ‘The basics’ section below and familiarize yourself with the ‘Safety’ 
section above.

4.	 Download both (i) the LINK App by Nucleus Coffee Tools, and (ii) the LINK 
Studio pro logging software to your computer desktop, via the Nucleus Coffee 
Tools website.

5.	 Install latest firmware from the Nucleus Coffee Tools website or LINK Studio.

6.	 Familiarise yourself with the features and terminology of the roaster, via 
information on the Nucleus Coffee Tools website. 

The correct way to test the roaster is to start it with no beans. It will heat up for 10 to 20 
seconds, reaching about 90 degrees Celcius.

Then a message will flash up: “Heat too fast. Please check beans.” At this point, the machine 
doesn’t stop, but it begins the cool-down cycle and runs for another 10 to 20 seconds until it 
has cooled down to about 40 degrees. At this point, it stops.

Running this test is a good way to be confident that everything is working as expected. This test 
will also generate a log file so it can be used to check that you have set things up correctly for 
collecting roast logs.

Note: that at each 150 run motor hours unit is taken to your countries service partner for a 
preventive Maintenance.

At 250 run motor hours, preventive maintenance has yet to be undertaken your unit will notify 
you that this servicing is a must.

Failure to adhere to servicing requirements may void remaining the warranty on your unit.

Download LINK App and  
LINK Studio

Activate warranty and learn 
about features
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THE BASICS

STEP 1

Place the density tube on a scale and tare 
the scale. Use a level dose of coffee into the 
density tube and make note of the weight of 
the beans (eg. 65g).

A ‘level’ dose is when the green coffee fills 
the tube, and is levelled off by the lid. Do not 
compress the beans into the tube. 

STEP 2

Set your power (eg. 220v) and Density Tube 
using the Preferences Tab in the LINK App.

Unsing the ‘Profile Selector’ tab, enter the 
Processing and Varietial of the green coffee 
you to recieve a profile recommendation.

STEP 3

Remove the chaff collector and load 50g-100g 
of the same green coffee into the roaster using 
the dosing cup. 

The LINK cannot be used for roasting more 
than 100g of green coffee at a time.
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STEP 4

Put the chaff collector back on, select the profile that 
the LINK App has chosen for you and click the start  
(     ) button to begin roasting. Ensure the chaff collector 
lid is in place as shown in the diagram.

Logging First Crack (FC) can be done by clicking the far 
right (     ), then middle button (     ) on the roaster, or via 
the LINK Studio by clicking the FC button.

STEP 5

When the roaster has cooled down and stopped,  
take off the chaff collector. 

Pick up the whole roaster with both hands.  
Tip the roasted beans into a bowl, jar or bag.

Ensure that any chaff is cleaned from the chaff 
collector before beginning your next roast.  
This must be done at the end of every roast.

THE BASICS

LINK Basics and Welcome
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AGEING THE COFFEE

CLEANING

Coffee changes flavour very rapidly during the first week after roasting, and the most rapid 
changes take place in the first few days. Waiting before using the coffee is known as ‘Ageing’ 
the coffee. The purpose of resting is to let the coffee degas, to allow the clarity of qualities to be 
improved.

The LINK profiles are designed to allow quick assessment if you’re in a rush. The style of the 
roasts – starting from an ambient temperature – means that you can cup or brew immediately 
post-roast with the certainty of a fair assessment. However, note that the profiles are designed to 
show the coffee at their best after some ageing. 

The right ageing parameters are of course subject to change for each coffee, depending 
on processing method, roast style, profile, development % and more. As a general guide, we 
recommend the following:

Cupping: Immediately to 72 hours after roast 
Filter: 2-12 days after roast 
Espresso: 3-14 days after roast  
Omni: 2-12 days after roast

Brush off any loose chaff. Wipe the outside of the roaster with a damp non-abrasive cloth. There 
will be a build-up of coffee oils in the roast chamber over time. We recommend that you do not 
clean the roast chamber, but a dry cloth can be used if desired.

For regular cleaning of the inside of the inner glass of the chaff collector, use a paper towel. For a 
deep clean, disassemble the chaff collector and soak the glass in a solution of a suitable cleaner 
such as PulyTM Caff detergent, CafettoTM Espresso Clean, Simple GreenTM or other non-caustic, 
non-abrasive cleaner. Reassemble the chaff collector before use.

Learn more about maintenance and care for the LINK roaster via our website: 

IMPORTANT: You need to be particularly careful not to touch the sensitive tip of 
the temperature probe that sticks into the roast chamber part way down. Do not 
clean the tip of the probe.

Maintenance and Care
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SELECTING A PROFILE
A roast profile/power curve tells the roaster the exact temperature required at each time 
during the roast, and is recommended by the LINK App. 

Altohugh the profile specifies when to end the roast (total roast time), the end of the 
roast is controlled by logging the First Crack (FC) to start the DTR%, or development 
percentage. Your roaster comes pre-loaded with a set of profiles, divided by Roast Style 
(eg. Espresso), Roast Plan/Profile Pack (eg. Espresso C), and are designated by numbers 
(eg. 206.5). 

 
To achieve the best results it is necessary to match the profile and DTR% to the beans.
Roast time & temperature logs are recorded automatically whenever you roast in the LINK 
Studio. It will also record on the roaster, provided this Preference is turned on.

To load a new roast profile via the LINK roaster:

Click the (    ) button to select a Roast Style and Roast Plan, browsing with the (+ ) and  
( – ) buttons and making your selection with the Play (    ) button.  

To select a profile ,click the Profile (       ) button second from the right. 
 
Browse with the ( + ) and ( – ) buttons and make your selection with the Play (     ) button. 
Or, keep clicking the Profile (       ) button until the profile you want shows up on the 
display.

Press the Start (     ) button to load onto the roaster.

To load from the LINK Studio via a computer/laptop:

Plug the supplied Tether cable into the back of the roast unit and your computer.

Click on the connection icon in the link pro software that is located next to the green tick. 

Then, click the Profiles tab and select the Roast Style, Roast Plan/Profile Profile, and 
Profile/Power Curve that was suggested by the profile selection app. 

After making your selection, the profile will automatically transfer to the roaster. If not, 
make your selection and then click the hand icon in the bottom right corner to send to 
the roaster.

Press the Start (     ) button to begin roasting.

Track the live roast progress with the Link Studio logging software to see the roast 
curve, log colour change or development %. Alternatively, you can monitor the majority of 
these basic functions directly on the unit display screen if you don’t wish to connect the 
Tether to a desktop.

See more on p. 26-28.
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ROAST LOGS

MEMORY STRUCTURE

A roast log is a saved record of each roast profile, and will be saved to the internal memory of the 
LINK roaster. Roast logs are automatically saved in the folder called Logs. 
 
To access the roast logs, click on the connection icon when your roaster is connected to the Link 
Studio software, and click the Logs tab. You can see the profile data breakdown or write notes 
in the tasting notes section under the ‘About this file’ tab. Each roast log can be exported to pdf 
format or in their original format (.npro) to be shared, or edited in the Studio to make a new profile.

The roaster does not date the log files; instead, it gives them sequential numbers. This makes it 
easy to keep the files in order, but if you need to record the actual roast date you must include it 
in the tasting notes. You can verify that logs are being generated by running a test roast (see the 
‘Testing’ section above).

If you need to reformat your memory board as part of a hard reset, see the link below:

The internal memory of the LINK will notify you when it is at 80% capacity, about 300 logs. 
At this point, it will ask you for permission to begin to automatically override the oldest logs. 
Alternatively, you can choose to manually store the logs in a separate place on your computer if 
you wish to archive them longer.

To archive or delete logs, click on the connection icon in the Link Studio software that is located 
next to the green tick. Then, click the log tab. At the top left of that screen, you will see an open 
folder link in blue. Open this link and remove to bin or achieve the profiles you wish to delete/store.

Once complete, make sure to click the re-sync button in the middle of the top right-hand side. 
wait for the connection tick to return green before switching off the unit or removing the tether 
connection.

Failure to complete these steps when removing files may lead to the unit needing to be reset if 
the unit is not synced correctly to the server.

Managing the LINK memory

Reformat the memory board
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DENSITY TUBE

The Density tube provided provides a key to navigate and  
choose the right sample profile for each coffee with ease.  
An accurate density reading requires approximately 80g of  
green coffee, depending on shape and size. 

 

See below the steps for recommended density assessment: 

1.	 Weigh out 80-100g sample into a dosing cup.

2.	 Remove the lid and zero off the empty density tube  
on a scale.

3.	 Place the density tube into a sample coffee tray or shallow dish.

4.	 Gently add your weighed-out green sample and overfill the density tube until excess 
starts to fall into the tray below.

5.	 Invert the lid of the density tube so that the logo side is face down against the 
coffee.

6.	 Gently move the lid back and forwards across the top of the tube, pushing off 
excess coffee into the below tray. Ensure not to press down or compact the coffee.

7.	 Continue the movement until a level surface is achieved enabling the lid to sit flush 
with the top of the tube.

8.	 Remove the lid and weigh the green coffee in the density tube on the scale you 
previously used.

9.	 This weight is the density number, ready to type into the Profile Selector in the 
LINK App.

10.	 For higher precision, we recommend repeating this measurement two-three times 
and calculating the average number for the app.

Density Tube

Video: How to do a  
Density Measurement

IMPORTANT: There are different sizes of density tube. 
Use the prompts in the LINK App to determine which  
density tube you are using.
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PROFILING WITH THE LINK APP

The LINK App is your compass to guide you through the accurate selection of a 
recommended start profile for any coffee. Once you have completed the density assessment, 
open your LINK App. 

Select the Profile Selector, then the new sample entry tab. The other options (Advanced Dial-in 
and Manual Profile Selection) are to be used when wanting more specific recommendations, eg. 
when adjusting a profile.

Fill out the three sections for your profile recommendation:

1.	 Density Reading: 
Enter the number from your density assessment. Note the density information is drawn from 
a 0.5g-1g range so don’t be alarmed if you are 0.3-0.5g different in each reading.

2.	 Process: 
Choose from the 7 options which are categorized into broad groups. Please select a group 
that best represents the style of processing of that coffee sample.

3.	 Variety: 
This last input is for the future development of the app. Please type in the sample coffee 
variety.

This input will allow Nucleus Coffee Tools to further refine the profiling algorithm for the future. 
Currently, this can be left blank if you wish.

Click Done. You will now be shown the recommended profile for your sample.

Select this profile on your Link unit via the aforementioned buttons (p.14). if using a tethered 
connection, you can send the profile from the LINK Studio to the roaster. 

Add 50-100gm of your green coffee sample into the roaster. Secure chaff collector and press 
play. You will be asked to input the batch size, and if the Fan Adjustment setting is turned on, to 
input any recommended fan adjustments. After this, push Play to start.

 

Fan adjustments: 

Since May 2024, the LINK and its firmware have included the option of fan adjustments prior to 
starting a roast. 

The profile provided by the LINK App may also have a fan adjustment recommendation (eg. 
+0.005) – this is used to ensure that any particularly dense coffees are able to oscillate and move 
like other coffees. 

If provided with a fan adjustment number, ensure to enter this prior to starting your roast.

IMPORTANT: Before roasting, use the Fan Calibration in the LINK App to input your 
alitude (p.32). This will provide a recommended fan setting for your roaster, which 
is important for maintaining consistency in heat application. 
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SAMPLE PROFILE PARAMETERS
The LINK roasting profiles have a standardized roast time, temperature increase and 
development % (DTR). To provide an honest assessment of a coffee we strive to get as 
close to the target with through the LINK App and its profile selector function.

The standard range for a coffee sample (Cupping) is between 7-12% development and 4-6 
degrees Celcius temperate increase after First Crack. The standard roast is between 6:30-
7:00min. Recommended development of 9-10% if manually terminating.

Allowing a core profile to run automatically you will generally sit within these parameters:

•	 Expect coffee to have first “pops” between 5:50min and 6:10min.

•	 And rolling the first crack to be around 6:00 – 6:20min.

For this, log the point of First Crack at the rolling crack where there are 2 or more consecutive 
pops and a continuation of the first crack from there. At this point click the FC button on the 
logging software or by hitting the far-right menu button followed by the Play button to activate 
the first crack development timer.

For a rolling crack between in a window of 5:50-6:10, the user is recommended to manually 
terminate a roast if the development counter is above 10.5% development, and the auto 
termination has not come into effect. This can be done by + and then – on the unit or simply 
clicking end on the software.

•	 If a rolling crack occurs after 6:30min you may want to consider re-roasting the sample on 
a higher-powered profile. Please consider that for every 5 seconds late, choose a profile 
0.5 higher in the profile number.

•	 Eg a coffee rolling crack at 6min25 using 209.5 profile. Selecting profile 210.5 will speed 
this up to approximately 6min15.

Alternatively, if a profile has an early rolling crack before 6:00min you may consider applying the 
same principle in reverse. For every 5 seconds before 6:00min look to remove 0.5 in the profile 
number.

Eg a coffee rolling cracking 5:50 using a 209.5 profile I would suggest that 208.5 be used for a 
correctly developed expression.

IMPORTANT: Note that this is generalised information and that the 
above may not apply specifically to each roasting profile. 

Logging and modifying First Crack
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ADVANCED DIAL-IN
This LINK App feature is to be utilized to provide an adjusted profile recommendation, if 
your coffee hasn’t behaved as anticipated. It is to be after you run a new sample entry 
and perform a roast based on the initial recommendation.

Using the “new sample entry” function the profile suggested will provide an estimated first 
crack window (eg. 5:50min to 6:30min). During this first log, It is best to take note of the 
time of audible First Crack (when it has two or more consecutive “pops”). 

Please note some coffee samples or specific coffee species will not have an easy-to-define 
first crack (these samples are best to leave the roaster running its auto-programmed 
functions of the suggested profile in the first stage). 

If your coffee has a First Crack outside of the estimated window, you can use Advanced 
Dial-in mode to provide an adjusted recommendation. Note that this mode needs a defined 
First Crack point to further refine an exacting profile for your sample.

Once you have completed a roast and have the exact time registered for First Crack, please 
go back into the profile selector and in the next screen, select Advanced Dial-in.

•	 In the first line enter the First Crack. Enter the minute on the left and the seconds on 
the right. Please enter minutes as a single-digit number and seconds as a two-digit 
number (i.e. for 6:01min you would enter “6” on the left in the minute box and “01” in 
the right second’s box)

•	 Next please enter the Profile Number that the sample was previously roasted on in the 
start profile box (i.e. if your new sample entry suggested 207, you would enter 207 
into the start profile box).

•	 Once the 3 data boxes are populated, please select done. The information will be run 
through the algorithm and a new solution for the suggested profile with be shown on 
the next page.

Select this profile on your unit via the menu tab or send it to the roaster when the tether 
connection is made by first selecting the new profile in the Link pro software profile inbox 
and then clicking the send to roaster button in the bottom right corner.

Weigh out another 50-100g of the same green coffee from the first roast into your dosing 
cup. Place in the roaster and then put on the chaff collector and press play.

Advanced Dial-in
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TIMER MODE

RESETTING

FIRMWARE UPDATES

The roaster has a timer mode so that you can use it as a brew timer. Put the roaster 
into timer mode by pressing both Profile and Menu (       +     ) buttons together.

Press Profile & Menu (       +     ) buttons together again to go back to automatic 
roasting mode.

In timer mode, the Start (     ) button starts and stops the timer, but it does not 
control the roaster.

Occasionally the memory where the profile details are stored can become corrupt, for 
example, a power failure during a roast could cause this.

This can cause unusual characters to appear on the display and the roaster may become 
unresponsive. To reset the roaster and restore factory defaults, hold down the Start (     ) 
button while you turn the roaster off, then back on again. 

IN THE UNLIKELY EVENT OF AN EMERGENCY: 
You can stop the roast early by pressing Start (    ) then the Minus (    ) button 
while it is roasting. Stopping the roast early puts the machine straight into cool 
down. (Turning the machine off will also stop the roast – it will automatically 
enter cool down if you turn it back on again straight away.)

The LINK roaster has frequent updates to its operating firmware, which are provided 
at no cost to all users. This includes new features, new profiles, and improvements to 
existing features and functions.

Any new updates will be notified to you through a message popup when opening the 
LINK Studio software. Please follow the prompts to download and install new firmware 
our profiling updates.

For more information, see this page:

Learn about Firmware updates



21

LINK STUDIO / ROASTING SOFTWARE

BASICS
You have a stable connection between the unit and the computer when the tick icon is green.

When the connection icon shows as severed and a triangle with an exclamation mark is shown you 
will need to re-establish the connection. You can re-establish connection by switching the unit’s 
power off and on again or by going to the menu bar clicking on Tools > Connection tools > and 
selecting Re-sync. 

CLASSIC FUNCTION & EDITING
For profile editing its recommended that the profiles are balanced out using the smooth point 
function between adjustment nodes. This can be found in Draw > Smooth Point, or Draw > Smooth 
all (p. 29).

When editing a profile, predicting the time of the first crack (FC) will give a suggested development 
percentage.

Adjusting the profile DTR% (development %) adjusts the temperature increase of the profile from the 
point of the first crack.

Clicking on an adjustment node and moving the temperature click function up or down is the 
easiest way to make micro-adjustments to a custom profile. 

ADVANCED
Once you’re familiar and comfortable with the LINK operating firmware software, you can yourself 
greater access to the link software capabilities (p.23). To do this, click on the Options tab in the 
LINK Studio and select a different difficulty setting to unlock more features (eg. Engineer Mode).

Note that you should not adjust the back end settings of the LINK profiles, otherwise you risk 
corrupting the functionality of the LINK App and its profile selection.

See tutorial videos
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LOGGING STAGES

CC you click CC after the drying phase is complete and when you see the coffee bean 
colour starting to change to a light straw through the visual sight. This will log time spent 
in the drying phase and mallard reaction phase shown as a proportion of the overall roast 
% and total temperature increase during each of those phases.

FC should be clicked at the first clearly audible consecutive pops that continue to crack 
from that point. If you believe you call early then re-click at the correct time to override 
the original selection. Once the clicked increases average, the development % and time in 
the development counter start.

END should be clicked when you want to manually terminate a roast earlier than the 
preset time for that profile. Use development % recommendation for suggestions found in 
the core profile explanation.

FE Is if you are manually profiling an espresso log and the first crack has ended.

SC is for dark roasts where you are taking profiles into that very dark range. This 
function will only be utilized if someone has made a custom profile with manually altered 
development (DTR%) range in engineer mode.

SE for full carbonized roasts where the first crack is completed. Intentionally Roasting to 
this level is not recommended.

MODES AND BUTTONS 

LIVE ROASTING LOGGING FUNCTIONS 

You will see several logging functions on the live roast feature within the LINK Studio. 
Here is a glossary of what they mean and how to utilise them. 

CC = Colour change

FC = First crack

END = Profile termination

FE = First crack end

SC = Second crack

SE = Second crack end
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LINK STUDIO - DIFFICULTY MODES

1.	 Connect the tether cable to the roaster and turn on unit.

2.	 Open the LINK Studio desktop software. Ensure that the roaster is connected, 
by locating the green ‘tick’ icon in the menu bar. 

3.	 When connected, navigate to the top menu bar.

4.	 In the menu tab, select the Option dropdown.

5.	 Navigate to Difficulty and select your experience level with Link studio. 
 
- Basic is the default that allows a limited function to only the key 	operational 
features. 
- Advanced and export modes allow the user to have more freedom to the 
back-end parameters that control the heating phases, precision and monitoring 
attributes of the roaster. 
- Engineer mode unlocks all attributes of the roaster. Please note that this 
mode should only be utilised by someone with prior experience in kaffelogic or 
link studio functionality.

6.	 In all modes, we advise you don’t deviate from the advice of recommended 
settings the program will suggest for you.

7.	 If you don’t know what a setting do we strongly recommend that you leave 
it as is. Failure to follow advice may lead to damaging the unit and voiding a 
user’s warranty.

IMPORTANT: We recommended following all software prompts and 
suggestions made and not to tinker with settings the system suggests you 
leave as is.

Changing difficulty settings  
and editing a profile

Unlocking the full functionality of the LINK software.
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DTR ACTIVATION
The LINK and LINK app profile suggestions were designed to function in DTR 
mode. If it is not active, please follow the steps and re-activate it :

On the unit, press the far-right (     ) button until you get to a screen called 
preference and push play (     ).

The options you should now see is - for levels and + for DTR.

Please select the (    ) button to activate DTR. Confirmation should appear on the 
screen of DTR Activation.

The main screen now reflects the development percentage of a profile. This is the 
target development percentage when the first crack is logged.

When you click the first crack logged it will terminate when it hits that point.

If you don’t log a first crack, it will continue roasting to the default parameters. 
Failure to follow advice may lead to damaging the unit and voiding a users warranty.

ARABICA ADVANCED
The Arabica Advanced feature of the LINK App allows users to receive more specific 
recommendations for roast profiles, based off the screen size of their coffee.

In the LINK App, open the Preferences tab. There are several Preference options, including 
Arabica Advanced. Turn this on, then click ‘Return’ to go back to the home screen. 

Now, when entering Profile Selector mode, the second pop-up that will appear will ask for the 
screen size of the coffee being roasted. Make a selection, then proceed to enter the remaining 
coffee information to receive a profile recommendation. 

If you do not know what screen size is, or do not know the screen size of your coffee, it is 
advised to not use this feature, or to select ‘Unsure’. 

Using Arabica Advanced
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BATCH SIZE
The Link system is designed to be optimised in a range of 50g-100g. Your selection of 
the volume of coffee you can input can be made as small as a single gram difference 
between the optimised range. 

On the LINK roaster, you make your batch size selections when first pushing the play 
button. Pushing play a second time (once the batch size for the volume of coffee is 
entered) will start the roast.

You don’t need a different profile for smaller or larger batches. The Link system will 
calibrate its fan and heating element to suit each volume. If insure, the best middle ground 
is to start with 80g of green beans. 

Please note that even though the batches can be roasted as small as 50g, a minimum 
sample size of 80g and above is needed for a accurate density reading to best select your 
profile. The size of the previously selected batch will be held unless you reset the unit.

Please note that failing to suggest the correct batch size for the input of coffee may result 
in triggering the heat to fast alarm if the green weight is lower than the selected volume. 
A failed roast may also occur if the green volume is too large as the bean will not have the 
correct movement within the chamber.

VARIABLE BATCH SIZE / ADVANCED ROAST  
DETAILS
The Advanced Roast Details feature of the LINK App allows users to receive more 
specific recommendations for roast profiles, based off the batch size of the coffee 
being roasted.

This feature is particularly useful if you are roasting two batch sizes of the same coffee – 
for example, 100g then 50g of the same coffee – but want the same quality/result. 

In the LINK App, open the Preferences tab. There are several Preference options, including 
Advanced Roast Details. Turn this on, then click ‘Return’ to go back to the home screen. 

Now, when entering Profile Selector mode, a pop-up will appear after the Density, Process 
and Variety are entered. Make a selection, then proceed to the next window to receive a 
profile recommendation. 

Using Advanced Roast Details

IMPORTANT: Do not roast more than 100g at a time. The Kaffeelogic BOOST Kit is 
not compatible with the LINK sample roaster.
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PROFILE PACKS/ROAST PLANS

The LINK comes with a wide range of profile packs/roast plans for each Roast 
Style, which contain the roast Profiles.

A Profile Pack/Roast Plan can be thought of like a folder, which contans the roast 
profiles/power curves. Each Roast Plan follows a specific development percentage, 
rate of rise increase, time of 1st crack and arc of the roast curve.

As there are many different ‘packs’ of profiles, this allows for many variations, giving 
the user the freedom to adapt their preference of taste or purpose of use.

Each profile pack is differentiated by a letter (eg. A,B,C,D,E). This letter will be 
present after the profile number e.g. 213 NCT (D)

In the above example, 213 is the reference number of which profile has been 
suggested to the user from the LINK app. NCT stands for, Nucleus Coffee Tools, 
and is there so you know this is a profile designed, tested, and refined by Nucleus 
Coffee Tools. The letter (in this example D), references the profile pack chosen.

Example: CUPPING D 12% PACK 

These profiles are designed to be your Default pack that will generally suit a fair 
expression for all styles of coffee. They are the most balanced in the time 1st crack 
should fall and the time spent in development % whilst optimising roast stability and 
control.

Best suited: 
These profiles are best for all-around cupping and filter expression. This pack 
provides a fair and honest expression of any process or variety of coffee. This 
should be your reliable go-to if ever in doubt, as it will always give you the best 
reference point.

Expected crack window: 
5:40 - 6:05min

Optimised rolling crack Range: 
5:45 - 6:00min

See all available Profile Packs
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Accessing Profile Packs Through Studio

Access through the Link studio start by connecting the tether cord between the Link unit 
and your computer.

When the green tick appears to show connection, click on the bonbon icon to the immediate 
left of this to open the menu. At the top of this pop-up menu, there will be three tabs. Click 
on the middle one called ‘Profiles”.

Start by making sure your profile pack file is up to date with the most recent version. Note 
this update can take 2-5 minutes.

Next in the “Pack” drop-down access the Letter group  
or development 12% that you wish to select as a  
reference. 

Once selected to the right of this a second dropdown  
will appear that allows you to navigate through all the  
different profiles within that inbox.

Find the one you are looking for and click the little  
send to roaster icon on the right of the profile selection 
 you have made, and the profile will be sent across to  
your unit.

If you wish to set up a different profile selection, go back 
to the Pack drop-down and select which inbox you wish 
to load.

To access directly from Roaster Unit 

Push the far-right menu tab 4-5times until you see the selection for the profile pack

Push the play button to open the profile Preference selection.

Using the (    ) or (    ) button navigate through the inboxes until you find the profile pack inbox 
you are looking for.

To confirm the change push play which will return you to the main screen.

To access the profile within that inbox now push the fourth button from the left.

You can navigate increasing through the profiles by continuing to push the profile button or 
also by using the + button.

You can also use the (    ) button to navigate from the highest profile backwards.

If you overshoot your selected desired profile number use either the (    ) to increase or   (    ) 
to decrease till you are on the right number or profile, you would like to roast

To load push (     ).

Note that unless wanting to change to a different profile pack a user does not need to 
continually enter the preference menu as the selected profile pack will be held, unless the unit 
is reset.

Selecting profiles from  
the LINK Studio
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PROFILE PACKS/ROAST PLANS: OVERVIEW

 ROAST STYLE

ESPRESSO FILTER CUPPING OMNI

A  B C  D E  

A  B  C  D  E  

A  B  C  D  E  

* The hundreds of roast profiles for the 
LINK system are divided into different 
Roast Plans, also referred to as ‘Profile 
Packs’. 

These are like folders of profiles, each 
of which has a different approach to 
roasting based on the roasting style 
and the qualities of the coffee.

* Roast plans are determined by the 
roast style (Cupping, Filter, Espresso or 
Omni). Each Roast Plan is designed to 
achieve different results depending on 
the roast style.

See all Profile Packs/Roast Plans

* Within each profile pack (eg. Filter E) are a number of 
Roast Profiles/Power Curves. These are denoted by a 
number  (eg. 207), and represent the recommended roast 
approach as recommended by the LINK App.



29

EDITING A PROFILE

The LINK also provides the opportunity to edit and create your own profiles, 
using the LINK Studio software. These profiles can also be exported and 
shared with other LINK users.

To edit a profile, access the profile you wish to edit via the LINK Studio (p.27). 

Rather than exiting the “Profiles” tab, select the pencil icon next to the Profile 
number. The profile will then open in editing mode. 

Use your cursor/mouse to select any point along the roast profile curve/power 
curve, and drag to adjust its position. 

You can also use the numeric codes along the base of the LINK Studio window to 
make more specific adjustments to temperature and time. 

To insert a new point in the Roast Profile Curve, click on the spot where you wish 
to insert a new point. Then, select Draw > Insert Point from the LINK Studio banner 
menu. 
 
To smooth out an adjustment and make a smooth power curve, select Draw > 
Smooth Point. To smooth out the entire power curve, select Draw > Smooth All. 

In the About This Profile tab, you can name the profile, list yourself as the Profile 
Designer, and provide a description of the roast profile. 

To save, click the Save icon or File > Save. To share and export as a PDF, click File > 
Export. 

Make or edit your own profile
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Altitude calibration

1.	 Download or open a mobile app that allows you to see your current M.A.S.L (Metres 
Above Sea Level).

2.	 Once your MASL has been established open your Link App.

3.	 Click on the fan calibration selection to the right .

4.	 When the next screen opens populate your altitude in the top box.

5.	 Next, select the unit power you are using. Push done.

6.	 The solution screen will tell you the Calibration point for your unit.

7.	 Turn on your link unit.

8.	 Push the far-right menu (     ) button once till you see the option “altitude trim”.  
In newer versions of the LINK firmware, this may be listed as ‘fan anemometer’.

9.	 Using the (     ) or (     ) button set the number to the suggested range.

10.	 Push the (     ) button to confirm and save.

11.	 Note this setting will hold unless the unit is reset, or the number is manually adjusted to 
another setting.

12.	 If you want to confirm the movement of your coffee or make a custom increase or 
decrease from the suggested range by the app, put in your desired roast volume.

13.	 Note that if you have the unit set up to 50g on the roast profile the green you should 
put in should also match.

14.	 The best is to have your profile volume at 100g and put 100 grams of green coffee in.

15.	 When you start the fan speed trim it will only activate the fan so the element will not 
engage to roast the coffee.

16.	 Place your hopper on top and ensure the movement matches the stage 1 video 1 v log 
video on altitude calibration. 

ALTITUDE CALIBRATION

Altitude calibration

IMPORTANT: Altitude calibration enables your roaster to replicate the atmospheric 
conditions of sea level. If roasting for the first time, or changing location (eg. from 1200 
masl to 2300 masl), ensure to recalibrate the fan speed of your roaster using the below 
steps.
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AUTO-HOLD OF THE FIRST CRACK
Earlier firmware versions for the Link had an auto first-crack memory feature embedded into the firmware. This 
feature would be activated when a user selected a profile, started a roast, and logged a reference point of the 
first crack for the DTR system to activate.

By logging the first crack, this becomes the last data point needed for the DTR system on the Link to adjust 
the roast time and RoR pitch. It ensures that the target development % of the profile pack used is reached, 
even if the first crack occurs earlier or later than the default setting. At the completion of the roast, the 
point at which you logged the first crack would be automatically remembered and repeated as the first crack 
reference for the next roast, provided the user did not change the selected roast profile, reset the unit, or turn 
it off and then on again. This means that if you did not load a refreshed version of the core profile and the Link 
app suggested roasting the sample on the same core profile number as the previous roast, the reference point 
for crack and roast time outlined in the core profile would be automatically overridden by the logged point of 
how the previous coffee behaved.

This feature is great when roasting many batches of the same coffee, as it’s almost like setting cruise control 
while driving down the highway in your car. Once you set the first crack, it will remember the exact first crack 
time and termination point needed for the target development and desired roast degree. It will continue to 
mimic it for every roast automatically, so you don’t need to do anything manually. However, having it always 
on in a sample set is not always beneficial. If you don’t need to change the reference profile to a different core 
profile number but are roasting a different sample, you would want to be staring at a blank core profile that 
had no overriding pre-sets logged. Unless you selected a different profile and then reselected the same profile 
again to reset the hold memory, or you had reset/turned off the unit between the batches, this would not be 
the case, and the profile you started the roast on would be amended to the specifications of the last coffee 
you had roasted.

Recognising the benefits of this feature for production batch roasting of the same coffee and the need to 
turn it off when sampling many different coffees, we have created an optional preference into the firmware 
KN1007B-7.11. or higher firmware that allows the user to activate or deactivate it based on how they are using 
it.

Please follow the steps below to turn this feature on and off whenever you need:

1.	 Push the menu button (     ).

2.	 Continue pushing the menu button (     ) until you see the Preferences option.

3.	 Press the play button (     ) when you reach preferences to load.

4.	 On the first screen, you will see DTR and levels.

5.	 Now push the menu button (     ) once more.

6.	 ‘Always reset FC’ will appear on the screen.

7.	 You will see the option to select (    ) for No and (    ) for Yes.

8.	 If you want the first crack reference from the previous roast to be held until the completion 
of each roast from the logged point, then select (    ) for No. ‘Keep User FC between 
roasts’ will appear and is now enabled.

9.	 If you want the log point to hold the first crack reference until the profile is changed or the 
unit is reset or turned off, push (    ) for Yes. ‘Reset Profile FC Every Roast’ will appear and 
is now enabled.

10.	 This selection to activate or deactivate can be adjusted at the users’ discretion if they are 
running firmware KN1007B-7.11. or higher.
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This appliance is not intended for use by persons (including children) with reduced physical, 
sensory or mental capabilities, or lack of experience and knowledge, unless they have been given 
supervision or instruction concerning the use of the appliance by a person responsible for their 
safety. Children should be supervised to ensure that they do not play with the appliance.

(Instruction for Australia and New Zealand only)

This appliance can be used by children aged from 8 years and above and persons with reduced 
physical, sensory or mental capabilities or lack of experience and knowledge if they have been 
given supervision or instruction concerning use of the appliance in a safe way and understand the 
hazards involved. Children shall not play with the appliance. Cleaning and user maintenance shall 
not be done by children without supervision.

(Instruction for EU countries only)

This appliance can be used by children aged from 8 years and above and persons with reduced 
physical, sensory or mental capabilities or lack of experience and knowledge (person in need of 
assistance) if they have been given supervision or instruction concerning use of the appliance 
in a safe way and understand the hazards involved. Children shall not play with the appliance. 
Cleaning and user maintenance shall not be made by children unless they are older than 8 and 
supervise. Keep the appliance and its cord out of reach of children less than 8 years.

(Instruction for USA, Canada, and Japan only)

Visit the support pages at 
nucleuscoffeetools.com/support

FURTHER INFORMATION
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WARRANTY
Thank you for purchasing our product. We hope you are satisfied with your purchase and that it 
meets your expectations. Please read the following warranty disclaimer carefully before using the 
product.

Our product comes with a limited warranty that covers defects in materials and workmanship 
under normal use for a period of 1 year from the date of purchase. This warranty does not cover 
damage caused by misuse, abuse, or normal wear and tear. It also does not cover any incidental 
or consequential damages, such as loss of use, or inconvenience.

To make a warranty claim, please contact your Nucleus re-seller with your proof of purchase and 
a description of the problem. We reserve the right to inspect the product before approving any 
warranty claim. If we determine that the problem is covered by the warranty, we will repair or 
replace the product at our discretion.

In no event shall our liability exceed the purchase price of the product.

TROUBLESHOOTING AND FREQUENTLY 
ASKED QUESTIONS (FAQs)

In the event of an issue with the LINK roaster, or if you need to troubleshoot an error or 
unexpected occurence, we invite you to reach out to our team or to use one of the following 
resources: 

•	 The Nucleus Coffee Tools website has a list of FAQs, including error codes and 
troubleshooting with the LINK Studio, LINK App and the LINK itself.

•	 Within the LINK App and on the Nucleus Coffee Tools website, we offer a Virtual Roast 
Assistant (AI chatbot) that has been trained by our team that can provide live support in 95+ 
languages. 

•	 The Nucleus Coffee Tools Training YouTube channel offers a range of videos on how to use 
the LINK and its numerous features.

If you are in need of a service, repair or replacement part, your first point of contact should be 
your re-seller – the company, distributor or reseller from whom you purchased the roaster. 

If your re-seller if unable to assist you, please lodge a support request via our website. 

FAQs and Virtual Assistant LINK YouTube channel Lodge support request
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NOTES

SMA
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